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Computers depend on an operating system to work. The operating system manages the interaction of
hardware and software to provide computer functionality.

Your IBM NetVista PC has Windows 98 installed and ready to go. Windows 98 provides a number
of features designed to make your computer using experience enjoyable and productive. The more
you learn about Windows 98, the more you can refine and customize your work.

The operating system of a computer also brokers the relationship with peripherals and internal and
external devices, such as printers, disk drives, mouse, and keyboard. This module also addresses
using your PC to print to the Lexmark Printer installed on your local area network (LAN).

• Increase familiarity with and initial proficiency using your PC and Windows 98.
• Develop understanding of and ability to print to a Lexmark printer via the network.
• Develop understanding of and ability to use your CD/DVD and external floppy disk drives.

Prerequisites
This is an introductory course that requires no computer experience.

Glossary
The following terms and definitions are useful to know for this module:

Bit, byte
A bit is the smallest unit of data stored in a computer. 8 bits equals a byte. Data storage capacity
is typically measured in bytes using powers of 10. A kilobyte is 1,000 bytes, a megabyte is
1,000,000 bytes, and so forth.

CD/CD-ROM
Compact disc, or compact disc with Read Only Memory. CDs with data burned into ROM can
only be read, not written to.

Computer interface
The physical means by which you use and interact with your computer.

Default settings
The original settings for software or hardware as initially installed.

Operating system (OS)
The software that makes your computer run by facilitating the interactions between hardware and
installed software.

PC
A computer with its own microprocessor designed to operate independently of a mainframe. PCs
can be networked.

Overview

Objectives
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Your New Classroom Technology Bundle
You are the recipient of a classroom technology bundle that includes a PC computer running Win-
dows 98 and access to a networked LexMark printer. These technology tools are intended to enhance
both your work as an educator and the learning process in your classroom.

Let’s begin by reviewing the items in your classroom technology bundle and some of their main
features.

Your New PC
Together your PC and accessories provide a number of powerful features and useful resources.

Documentation
Your PC comes with a Quick Reference guide that provides useful information about your PC
and its operation. This document is a good place to start for an overview of your computer.

Computer Case
Your PC is enclosed in a case with a number of buttons, drives, ports, and sockets. These are
covered below.

Monitor
The IBM E74 color monitor is designed to sit on the top of your computer case. The accompany-
ing monitor stand can be used to increase the height of the monitor and provide the ability to tilt
and swivel the monitor. This monitor has its own user guide.

IBM Mouse and Keyboard
Your PC comes with a standard two-button mouse and Windows keyboard. The keyboard fea-
tures full-sized keys and is designed to be comfortable to use. Use of the mouse and keyboard are
covered in detail later in this module.

Floppy Drive
Your PC comes with a floppy disk drive. This drive reads and allows you to write to 3.5 inch
floppy disks.

CD Drive
To the right of the floppy drive is a high-speed CD drive for reading CD-ROMs and playing
audio CDs.

Sound and Speaker Options
Your PC does not have built-in speakers, however, you have the option to add these using the
speaker port on the back of the computer. You can listen to sound on your PC using headphones
by connecting them to the headphone jack located below the CD drive.

Connectors and Buttons
At the back of the computer case is a power cord socket for connecting the AC cord that brings
power to your computer. Also at the back of the computer is a panel with a number of connectors
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for connecting devices and cables, including:

• USB ports for connecting USB devices.
• Connectors for your mouse and keyboard.
• An Ethernet connector for connecting via cable to a network and the Internet.
• Audio connectors, including sound in, sound out, and microphone connectors.
• A VGA connector for connecting to and sending your monitor signal to an external monitor.

At the top left of the front of the computer case is the On/Off button. Note also that the separate
monitor has its own power socket for connecting an AC power cord, as well as its own On/Off
button and additional buttons for changing the settings of your monitor, such as brightness and
contrast.

Peripherals
A peripheral is an external or internal device that attaches to your computer and provides a certain
function. Make sure all peripherals are connected to the computer.

Mouse
Your mouse connects to the mouse connector on the back of your PC and has two buttons. The
left button is typically used to select and open items by clicking and double-clicking. The right
button is used to open a “popup” or contextual menu with a number of commands, any of which
you can select. The mouse is used to move the onscreen pointer.

Keyboard
Your keyboard connects to the keyboard connector on the back of your PC. It has keys for enter-
ing letter and number keystrokes as well as numerous keys for entering functions or commands.

Printer
Your PC can print to a LexMark printer on your local area network. This printer is connected to
the network using a Lexmark Marknet X2000 networking device, which allows multiple comput-
ers to share the one printer. In a classroom with five computers, for example, all five computers
can share the one networked printer. The printer has its own manual and software.

Floppy drive
Despite the growth of networks, floppy disks are still used for storing and transferring files. Your
PC, like most PC’s, has a built-in floppy drive in the front panel of the computer case.

Headphones
Your computer came with a pair of headphones, which allows any user to hear computer-gener-
ated sounds without disturbing others nearby.
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Introduction: The Windows 98 Operating System
When you turn on your computer, the operating system loads and begins its work of managing the
activities of the computer.

Turning On Your PC
With your PC set up and connected to a power supply, you are ready to turn your computer on. To
turn your computer on, push the round On button on the front left of your PC.

When your computer successfully starts up:
1. The computer makes a chime.

2. The screen brightens and a Windows 98 icon appears in the center of the screen in a swirl of
clouds and blue sky.

Windows 98 Logo

3. The Windows 98 logo disappears, replaced by the computer desktop.

4. Desktop icons appear at the left of the screen. Icons also load in the system tray along the
bottom of the screen.

5. An hourglass remains by the pointer until the startup process is complete. When the hourglass
disappears, the computer is ready to be used.

Troubleshooting Powering Up Your PC
If your PC does not start up successfully, you must respond to the situation and correct the
problem. The following scenarios are the most common. Refer to the Troubleshooting section of
your PC user guide for additional information.

Starting Up in Safe Mode
If Windows has difficulty starting up, it may start in Safe Mode. Safe Mode is a simplified
version of Windows. If your computer starts up in Safe Mode, follow these steps:

1. Allow the computer to start up completely in Safe Mode. Wait for the hourglass by the
pointer to disappear.
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2. After the startup sequence is complete, select Shut Down from the Start menu, and Shut
Down from the resulting dialog box.

3. After allowing the computer to shut down completely, press the On button to restart your
computer. The computer should start normally.

4. If the computer still does not start up, contact your site technology coordinator or appropriate
tech support for assistance.

Starting Up after a Previous Unsuccessful Shutdown
When you start up your computer after a previous problem shutting your computer down, Win-
dows may give you a message stating that the computer was not shut down successfully the last
time and that Windows is rebuilding itself. In this case, simply wait for the progress bar to com-
plete its movement from left to right, then allow your computer to complete its normal startup
sequence.

Power Issues
If the computer does not chime, make any noise, or display any light on the computer monitor,
then there may be a power supply issue. Follow these steps:

1. Make sure that the power cable is plugged into the wall.

2. Make sure that the power cable is plugged into the computer and monitor.

3. Make sure that the AC outlet on the wall is working properly.

4. Make sure that any item associated with the computer, such as a surge protector or extension
cord has all switches in the On position.

Other Power Issues — Connecting and Disconnecting Cables
The computer can also be damaged immediately or over time if certain cables are connected or
disconnected while the computer is on. To avoid such damage, follow these guidelines for con-
necting or disconnecting cables.

Cables that can safely be connected or disconnected while the computer is turned on include:

• USB cables, such as those used to connect to certain peripherals.
• FireWire cables, such as those used to connect to some scanners, CD-ROM burners, digital
cameras, and other peripheral devices.
• Ethernet cables, such as the one that connects your computer to the school network.

Cables that should only be connected or disconnected when your computer is off include:

• The Power cable, which connects the computer to the AC outlet on the wall.
• The Microphone cable, which connects an external microphone to the computer.
• Speaker and headphone cables, which connect external speakers and headphones to the com-
puter.
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The Windows Desktop
The Windows desktop appears as your computer completes its startup sequence. In this section you
will explore the basic layout of the desktop.

Desktop Icons
The desktop contains several standard icons along the left side of the screen. An icon is a picture
that represents a particular folder, file, or application on your computer to assist you with identifi-
cation. Becoming familiar with these icons will help you use your computer efficiently.

My Computer Icon on Windows Desktop

The standard desktop icons include:

• My Computer, which represents your hard drive.
• My Documents, which represents the portion of the hard drive where your documents are stored.
• Internet Explorer, the default Windows web browser.
• Network Neighborhood, a way to access other machines on the network.
• Microsoft Outlook, the email and personal information manager program for Office 2000.
• Recycle Bin, where files are discarded and removed from your computer.
• My Briefcase, a tool for managing and organizing files shared between two PCs.

Office Shortcut Bar
Your computer came with the Office Shortcut Bar installed and active. By default it appears along
the right edge of the desktop. It provides an easy way to open new or existing Microsoft Office
documents. The Office Shortcut Bar is covered in detail in the training modules on Microsoft
Word, PowerPoint, and Excel.

Upper Portion of Office Shortcut Bar

Taskbar and Start Menu
The Taskbar sits along the bottom of the desktop and is a very useful component of Windows 98. It
contains the Start Menu, which serves as a key access point for Windows. You can easily access
and open installed applications and Windows 98 features and settings from the Start menu.
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Start Menu Button

The Taskbar provides additional options for accessing and opening folders, files, and applications.
It displays buttons representing these opened computer elements and provides a number of ways to
manage desktop windows. Finally, it also contains a clock and the System Tray, where small icons
for certain installed applications appear.

   

          Task Bar, Left Side           Task Bar, Right Side

Executing tasks from the Task Bar is covered in greater detail later in this module.
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Interacting with the Computer and Onscreen Objects
In this section, you will explore your computer, many of its components and features, the different
types of objects that appear onscreen, and how to interact with them.

Navigating
Navigation is the metaphor for moving throughout your computer. You navigate across the desktop
and through the hierarchical levels of the hard drive. When you reach a target folder, file, or appli-
cation on the computer, you can then open and use it. Within an active file in an open application,
you navigate to access commands and select where to create your content.

Moving the Pointer
Move the pointer by moving the mouse. When you move the mouse up (away from you), the
pointer moves up the screen. When you move the mouse down (towards you), the pointer moves
down the screen. As you move the mouse left or right the pointer moves left or right, on the
screen. The speed at which you move the mouse correlates to the speed the pointer moves on the
monitor screen.

Onscreen Pointer

Selecting (Clicking)
To select an icon, click the icon one time. This will highlight the item by darkening the icon and
reversing the text color from black to white.

Example of One Unselected Item and One Selected Item

Opening (Double-Clicking)
Open an item by pointing to it and double-clicking, that is, clicking the mouse twice in quick
succession.

For example, when you double-click the My Documents icon in the upper-left corner of the
desktop, the window that opens displays the contents of the your My Documents folder. Also,
when you double-click an application’s shortcut, the application opens, or launches.

Moving Objects (Dragging and dropping)
Icons on your desktop and in folders can be moved to different locations on your computer.

To move an item follow these steps:

1. Place the pointer over an icon on the screen.
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2. Press and hold down the left mouse button.

3. Continue to hold down the mouse button while you drag the icon to its new location.

4. Release the mouse button to place the item in its new location.

"My Computer" — The Hard Drive and its Contents
When opened, the My Computer desktop icon displays a representation of all the elements of your
computer, including the hard drive, also known in Windows as the "C" drive, floppy or "A" drive,
CD or "D" drive, and folders for key settings such as control panels and printers. Double-click My
Computer to view its contents.

While the applications installed and files and folders created and saved on your computer are
stored on the hard drive, you typically access these elements from locations other than your "C"
drive.

Folders
A folder works the same as the folders in a file cabinet. A folder assists you with organizing your
files into groups for easy retrieval. You can “nest” folders, that is, place folders inside of folders.
Certain folders, such as the My Documents folder, are identified by a customized icon. Double-
click any folder to open it and view its contents.

  

Folder Icon

Applications
Applications are programs used to create documents and other files or to perform certain func-
tions, such as enabling browsing of the Web.

Application Icon for Microsoft Word

Applications can be opened from the Start menu, located at the lower left corner of the desktop.

Files (Documents)
Files or documents are the saved work created using an application. To help you identify the
application that was used to create a document, each application uses a unique document icon.

Microsoft Word File Icon
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Shortcuts
A shortcut is a small file that acts like a pointer to another file, application, folder, or remote
server. You can place aliases of items in convenient locations on your computer to provide rapid
access to items. Shortcut icons contain a small arrow as part of the icon itself.

Desktop Shortcut for Microsoft Word

For example, you may want to place a shortcut for a document or application you use often onto
your desktop. When you double-click the alias, the file or application it is associated with
launches, without you having to find that file or application elsewhere on the computer. To create
a shortcut, follow these steps:

1. Click to select the icon of the file, folder, or application for which you want to make an alias.

2. Right-click, then from the contextual menu, select Create Shortcut.

3. A shortcut is created in the same folder as the original item or on the desktop if that is where
the original is located. Move this alias to any desired, convenient location.

Windows, Window Elements, and Window Management
When you double-click a folder or file, or when you open an application, a window opens to
display the item’s contents. This window can be manipulated a number of ways to suit your prefer-
ences and accommodate your workflow.

Title Bar
The title bar is located at the top of each window and contains the name of the open file, folder,
or application. A solid color in the title bar indicates the window is the active or currently se-
lected window. An active window appears in the foreground of your desktop, in front of all the
other open, inactive windows. Inactive windows have a "grayed out" or faintly colored title bar.

Active My Documents Title Bar

Scroll Arrows, Channels, and Boxes
Often times the window contains more content than will fit within the viewable section. When
this occurs, you can use either or both the vertical or horizontal scroll channel to scroll through
the entire contents of the window. As you scroll, the scroll box moves up or down or left and
right in the scroll channel, indicating the distance to the end of the window. As you scroll you
will see the formerly hidden content of the window.

Horizontal Scroll Channel
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Scroll through the window contents by either:

• Repeatedly clicking the up or down or left or right arrows at the ends of either the vertical or
horizontal scroll channel.
• Click and hold any scroll channel arrow to move continuously and rapidly through the contents
of the window.
• Click and hold the scroll box and drag it up or down or left or right.
• Click the scroll channel above or below the scroll box to jump up or down or left or right.

Sizer
Use the sizer to resize a window.

1. Click and hold in the lower right corner of the window.

2. Drag the window up, down, sideways or diagonally to achieve the size window you want.

Moving and Positioning Windows
Windows can be moved around on the screen to make viewing objects behind it easier or for
organizing multiple open windows. To move a window, follow these steps:

1. Click and hold the title bar of the window.

2. Drag the window to the desired location.

3. Release the mouse button.

Menu Bar, Standard Buttons Toolbar, and Address Bar
Toward the top of any open window, you will see a menu bar, a toolbar, and an address bar. Note
that there is some redundancy in that you can execute the same command from more than one
place. For example, you can change the views of icons in any window using either the View
menu or by clicking the View button.

Menus are organized by functional categories; each contains a number of commands for working
either with the window or its contents. For example, you can arrange the contents of a window by
Name or Type of item by selecting Arrange by.... from the View menu.

Menu Bar in an Open Window

The toolbar buttons are useful for navigating and executing basic commands, such as deleting a
file or folder.

Standard Toolbar for Open Window
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The address bar provides a reference to your location within the computer's hierarchical direc-
tory. As you read the address from left to right you are moving "down" or "into" the lower levels
of this hierarchy. Each level is separated by a slash.

Contextual Menus within the Window
An additional way to access a number of commands for an open window, its contents and other
Windows 98 options is the contextual menu. Follow these steps:

1. Point to the inside of an open window, to the background of the window itself, not over any
icon.

2. Right-click. The contextual menu opens.

3. Select any desired command and click to execute.

Contextual Menu for an Open Window

Minimizing, Maximizing, Restoring, and Closing Open Windows
At the far right of the title bar for any open window are three buttons, from left to right:

• Minimize Button
• Maximize/Restore Button
• Close Button

Minimize, Maximize and Close Buttons

To practice executing these four commands, follow these steps:

1. Click the Minimize button to "collapse" the window to a button on the toolbar; click this
button to return the open window to the desktop.

2. Click the Maximize button to expand the window to fill the entire desktop.
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3. Click the Restore button, when in view, to restore the window to its last previous size and
location.

4. Click the close box to close an open window.

Using the Taskbar to....
The Taskbar is an incredibly useful element of Windows 98. By default it sits along the bottom of
the desktop but it can be moved to the top or either side of the desktop as well depending on your
preference. It can be enlarged and reduced by pointing to the inside edge of the toolbar, then press-
ing and dragging when the two-way arrow appears.

Developing your ability to effectively use the Taskbar can make you a much more efficient Win-
dows user. Let's explore the Taskbar in detail.

Opening a Program from the Start Menu
An easy and conventional way to open applications on your PC is using the Start Menu. Follow
these steps:

1. Click the Start Menu at the lower left of the desktop. The Start Menu opens.

2. Point to the Programs folder. Another menu appears to the side.

3. From the list of installed applications, select the one you want and click to open. Note that
you may need to point to another folder first before reaching the actual application icon.

Internet Explorer and Microsoft Office Applications, Programs Submenu

Opening a Program from a Taskbar Button
The Taskbar contains icons for opening certain programs, Internet Explorer for example. Simply
point to the button and click and the program opens.

Launching Internet Explorer from the Taskbar

Managing Open Windows from the Taskbar
Also, when a folder, file, or application is opened on your computer, a button with its name and
icon appears in the Taskbar. Clicking this button will cause the window for that folder, file, or
application to appear and disappear. This feature is useful for managing open windows on your
desktop.
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Button in Taskbar for Open File in Microsoft Word

Arranging Windows Using Cascading or Tile Views
You may want to arrange and view any number of open windows in these two views. Cascading
view places all open windows overlapping each other from top to bottom of the screen. Tile view
will arrange all open windows side by side in either vertical or horizontal arrangement. This is
particularly useful for comparing the contents of multiple windows. To select one of these two
views, follow these steps.

1. Point anywhere on the Taskbar except to the button for any open application, folder, or file.

2. Right-click and select either Cascade Windows, Tile Windows Horizontally, or Tile Windows
Vertically.

3. All open windows are rearranged as you selected. Select an alternate view or manually
relocate each open window as desired.

Minimizing, Maximizing, and Closing Windows from the Taskbar
An easy way to execute these commands from the Taskbar is to point to the button for an open
folder, file, or application and right-click. Select any desired option from the menu to manage
that particular window.

Taskbar Contextual Menu

Minimize All Windows and Show Desktop Commands
These two similar window management techniques are useful when you want to quickly return to
viewing only your desktop, with no open windows in the way. Follow these steps:

1. Point to the Taskbar itself and right-click. The contextual menu appears.

2. Select Minimize All Windows. All open windows collapse to their corresponding button on
the Taskbar.

3. To undo this selection, right-click again and select Undo Minimize All. The windows return
to their previous open condition.
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Another option that produces the same result is to click the Show Desktop button in the Taskbar.
With windows open on your desktop, click the Show Desktop button. The windows are mini-
mized and the desktop appears. Clicking the Show Desktop button again reverses the effect.
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The Start Menu in Detail
Think of the Start Menu as the gateway to your computer. A great many features and controls can be
quickly and easily accessed through the Start Menu. This section does not cover all the options in the
Start menu, just the most useful and commonly used ones.

Start Menu

Shutting Down, Logging Off
The first section of the Start Menu contains two commands, one for shutting down (or restarting)
your computer, the other for logging off the network (if you are logged onto one). The Shutdown
sequence is described at the end of this module.

Windows 98 Help Resources
Microsoft provides Help resources for its Windows 98 operating system. Follow these steps to use
the Help resources.

1. Click Help in the second section of the Start Menu. The Windows 98 Help window opens.

Help Option, Start Menu

2. Note that these resources are organized into three categories on three "cards" with a tab at the
top of each card.
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Windows Help Window

3. Click the Contents tab to bring the “table of contents” to the foreground. The Contents are
organized like chapters in a book. Click a book icon or the term next to it to display the subsec-
tions and topics within that "chapter." Each chapter may contain two or more subsections. Topics
with a question mark icon are actual Help topics. Click any topic to obtain a information and
related topics in the right pane of the Help window. Continue until you find your desired infor-
mation.

4. Click the Index tab to bring it to the foreground. Type a keyword in the keywords field or
choose from the list of available topics, indexed alphabetically. Select a topic from the list and
again, the information appears in the right pane.

5. Click the Search tab to bring it to the foreground. Type a keyword in the keywords field then
click Search. A list of topics is displayed. Select your desired topic then proceed as above.

6. Use the Toolbar buttons to navigate back and forth between visited topics, to hide the tabs, to
set Help window options or to go out on the Web for additional help resources.

Finding Files and Folders
Windows 98 features a search tool for finding files and folders on your computer. You can also use
the Find option to access and begin a search on the Internet. Follow these steps:

1. From the Start Menu, point to Find in the second section. A separate menu appears.
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Find Program, Start Menu

2. From this menu, click to select and open Files and Folders. The Find: All Files window
opens.

Find Submenu

3. Like the Help resources, this window is organized into sections with cards and tabs.

4. Click the Name & Location tab to bring it to the foreground. To search for a file or folder by
name, type all or part of the name of the file or folder in the Named: field.

Find: All Files Window

5. Select where you want Windows to search using the pulldown menu of the Look in: field,
then click Find Now.

6. The results are displayed in a window below your search string. Next to each result is the
“path” to the file from the top level of the hard drive.

7. Double-click any one of the returned results to open it.

8. Click New Search to clear the results of your search and begin a new search.
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9. You can search for a file containing a particular word, phrase, or sentence. Type the word,
phrase or sentence in the Containing Text: field, then select the location(s) to be searched and
click Find Now. Windows searches for and returns a list of files containing your search entry.

10. Click the Date tab to bring it to the foreground. To search for a file or folder by the date
created, last accessed or modified, click the Find All Files radio button, then choose from the
options beneath it. This feature is particularly useful to narrow your search to a particular win-
dow of time, and can be used in conjunction with a search on the Name & Location tab.

11. Click the Advanced Search tab to bring it to the foreground. This card allows you to search
by specific type of file, for example, only Microsoft Word documents. You can also constrain the
search to certain file sizes. And, as above, you can use this in conjunction with search strings by
name, location, and date.

Settings
Use the Settings items to adjust computer settings, set up printers, and more.

Settings Option, Start Menu

Control Panels
Control panels are programs that execute simple tasks or that work in conjunction with installed
applications on your computer. There are control panels for adjusting mouse and keyboard
settings,  for adding and deleting programs, and more.

Printers
Printer set up and settings are accomplished through the Printer Settings folder. Click the Add
Printer icon to have Windows walk you through the setup process for a local or networked
printer.

Documents
Point to the Documents folder in the Start Menu to see another menu containing recently accessed
files. Click any of these files to reopen it. You can also access your My Documents folder from
here.

Documents Folder, Start Menu

Favorites
Favorites is a place to store a list of favorite web sites you want to be able to easily revisit. It
appears as part of Windows 98 and in Microsoft programs such as Outlook and Internet Explorer.
Wherever you see your Favorites list, you can access its contents. Favorites are discussed in the
Internet Explorer module.

Favorites Folder, Start Menu
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Programs
We have already covered starting an installed application from the Programs menu, however, there
are a number of other features worth mentioning that are accessed through Programs.

Accessories
The Accessories folder contains folders and applications. Many of its contents are geared more
toward a home user. But some are valuable for any user.

Accessories Folder Contents

Here is a brief overview of key Accessories folder contents:

1. The Accessibility folder contains an Accessibility Wizard for creating computer settings for
users with special needs. The Microsoft Magnifier is a screen magnification program for the
visually impaired.

2. The Entertainment folder provides access to controls for your CD player, and if installed,
streaming media players, such as Windows Media Player. Media players can play other audio
files, including MP3 files, as well as streaming video. Education as a system is just beginning to
tap the potential of streaming media to support student learning, communication, and profes-
sional development opportunities.

3. The System Tools folder contains programs for maintaining your computer as well as a
Welcome to Windows tutorial, covered below.

4. In addition to these folders, there are a number of programs you may find useful, including
Notepad for creating simple text files, a calculator, even a paint program.

Windows 98 Tutorial
Your PC came with an installed multimedia tutorial that presents basic techniques for using your
computer.
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Opening and Using the Windows 98 Tutorial
To assist you as you learn Windows 98, Microsoft provides a Windows 98 tutorial. This multime-
dia tutorial is a visual, interactive lesson on Windows 98 fundamentals. For further instruction or
review on the topics covered so far in this module as well as other topics, follow these steps to
open and begin using the Windows 98 tutorial:

1. Point to the Start menu.

2. Click and point to Programs; a menu appears to the right.

3. Point to the Accessories folder at the top of this menu; another menu appears.

4. Point to the System Tools folder within this menu; another menu appears.

5. Point to Welcome to Windows and click to open it.

Opening Welcome to Windows

6. A window opens with a menu with four choices. Select Discover Windows 98 to begin a
tutorial on using this operating system.

Welcome to Windows Window

7. Follow the onscreen instructions to navigate throughout the tutorial and exit the program
when ready.

Windows Explorer
One last program accessed through the Start Menu is Windows Explorer, named as such because it
helps you explore the entire contents of your computer. Remember that your hard drive works on a
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model of hierarchical levels. You can navigate "down" or "in" to the computer then return to upper
levels or the top by coming back "up" or "out." Windows Explorer provides a way to quickly view
the contents of your computer, navigate, and open any folder, and work with its contents. To use
Windows Explorer, follow these steps:

1. From the Start Menu point to Programs then select and open Windows Explorer.

2. The Windows Explorer window appears divided into two panes. The pane on the left con-
tains icons representing the entire hierarchical hard drive directory. The pane on the right displays
the contents for any drive or folder selected at left.

Windows Explorer Window

3. Drives and folders may or may not have a small box at their immediate left. If they do, the
box will have either a plus sign, indicating there is an additional level of the computer directory
within, or a minus sign, indicating you have reached the last level for that particular folder, and
that it contains only files, not more folders.

4. Click the plus sign to open the next level of the directory. Click the minus sign to close a
level and return to a higher level of the directory. Note the vertical lines that help you track how
many levels "in" to the directory you are. It appears as though the icons are threaded by these
lines.

5. To open any folder and view its contents, click the folder icon. For example, clicking the My
Computer icon in the left pane displays its contents at right, including the floppy drive, "C" drive,
CD drive, and more.

6. You can also open a file or folder in the right pane by double-clicking.

Some PC users leave Windows Explorer running all the time, and prefer using it to access and
open the contents of their computer.
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Using Other Disks and Drives
Your PC is equipped with an internal floppy drive and CD drive. This section covers the use of
floppy disks and CDs with these drives.

Floppy Drive and Disks
The floppy drive is used mainly for writing and reading data, such as documents and small applica-
tions, to and from a floppy disk. In some cases, floppies are still used to install software. A floppy
disk is square and can hold up to 1.4 MB of data.

Inserting and Using a Floppy Disk

1. Hold the floppy disk with the label side up and the metal piece away from you, towards the
floppy disk drive.

2. Insert the floppy disk into the external floppy disk drive by pushing the disk all the way into
the disk drive until you hear and/or feel a click indicating that the disk is set in position.

3. Double-click My Computer. A window opens with an icon of the disk appearing as Drive
"A".

Floppy Drive Icon

4. Double-click the floppy disk icon to view the contents of the disk.

While many disks come pre formatted, others do not. A floppy disk must be formatted to work
with Windows before your PC can read it. Initializing is a process that the computer uses to
format a disk and to be able to read and write data to the disk. To initialize a disk, follow these
steps:

1. Insert an unformatted disk into the floppy drive.

2. If the disk is not already initialized, a dialog box will prompt you to initialize the disk.

3. Follow the onscreen instructions to proceed. Note that initializing will erase all existing data
on the floppy disk, however if you have never written any data to the disk, then there is no data to
lose.

4. The status of the initialization process is displayed. When initialization is complete, the
floppy is ready to be used.

Ejecting a Floppy Disk
To remove a floppy disk from your computer, press the button just below the drive. The disk will
eject itself.
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CD Drive
The CD drive reads CDs, both audio and CD-ROM, that have been inserted into the drive. CD-
ROMs contain data and are typically used for installing new software or for accessing programs,
including games, and data, including text, images, and movies. Audio CDs contain data in the form
of sound files. A CD-ROM holds approximately 600 MB of data.

Using a CD-ROM
To use a CD-ROM disk, follow these steps:

1. Insert the CD-ROM disk, with the label side up, into the CD drive at the right front of your
computer. You will hear some sound as the CD spins up in the drive.

2. Note that some CD-ROMs start up automatically. If so, a window will appear with the initial
contents of the CD-ROM. You may be automatically guided through the contents or presented
with onscreen instructions.

3. If the CD-ROM does not start automatically you will need to manually open it. To do so,
double-click My Computer. A window opens with an icon of the disk appearing as Drive "D".

CD Drive Icon

4. Double-click the CD drive icon to view the contents of the CD-ROM.

5. Use a CD-ROM disk as you would the hard drive or other folders on the computer by double-
clicking icons to open them. Follow any onscreen instructions.

To eject a CD-ROM from your computer, either point to the "D" drive, right-click and select the
Eject command or simply press the eject button located by your CD drive.

Playing an Audio CD
The computer can play audio CDs that you can listen to through an headset plugged into the
computer or by connecting external speakers to your computer.  (Note that your IBM NetVista
does not come with built-in speakers.) To play an audio CD, follow these steps:

1. Insert the audio CD as instructed above.

2. The CD should begin playing automatically; if it does not you can double-click the audio CD
icon to have it open in a CD or media player. You can also select the CD player from the Enter-
tainment folder in the Accessories folder in the Programs folder in the Start Menu.

3. Use the controls on the CD or media player to control the audio CD playback. For example,
you can select specific tracks, pause play, and more.
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Managing Your Work
The management of your files, folders, and applications is very important. Like your teacher’s desk
and file cabinet, if you do not have some form of organization, it is extremely difficult to keep track
of items and to use your resources efficiently.

The computer interface is a metaphor for a physical world workspace, such as your classroom, which
contains both a desk (and desktop) and file cabinet. In your classroom, you must manage papers.
Your papers may be loose or placed into folders, and those papers and folders can sit on your class-
room desktop or in your file cabinet. In your classroom file cabinet, you likely use some type of
organization scheme.

In your computer workspace, you have a desktop and hard drive. You must manage files. Your files
may be loose or placed into folders. Files and folders can sit on the desktop for easy access or be
located further within your hard drive. On your hard drive you will likely use some type of organiza-
tion scheme.

Organizing Your Hard Drive
Windows handles some hard drive organization for you. When you install a software application,
its components are placed in certain areas. For files and folders you create, however, you must
place and manage them.

Creating folders
Folders are a convenient way to organize items on the computer. To create a folder, follow these
steps:

1. Select the location where you wish to create the new folder. For example, your PC arrived
with an empty My Documents folder. You will likely want to create folders within My Docu-
ments to organize your work, perhaps by month, by subject, or by content area, or by some other
scheme.

2. From the File menu, select New, then Folder. Alternately, you can right-click in the open
window and choose New then Folder from the contextual menu. A new folder is created in the
active window.

3. The new folder's name is highlighted. Simply type a name for your newly created folder, for
example, Math. Folders can later be renamed by pointing to the folder, right-clicking, and select-
ing the Rename command. After naming a folder, click away from it to leave the name field.

Nesting Folders
Placing folders inside of folders is a practical way to organize your documents. Inside your My
Documents folder, you may want to create additional levels of folders for organizing stored files.
For example, within a Math folder, you may want to create additional folders, such as one for
Lesson Plans. Follow these steps:

1. Double-click the My Documents folder.
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2. Double-click the Math folder to open it. From the File menu, select New Folder to create
another folder nested inside the Math folder, which is nested within the My Documents folder.

3. Title this folder with a name useful for you, for example, Lesson Plans.

4. Within Lesson Plans, you may want to create folders for the different math areas, such as
Fractions or Operations.

There is no right or wrong way to organize. Use a scheme that best suits your own needs.

Working with Documents
You will likely find that skills developed using one program can be applicable to other programs.
Many commands are executed in a similar or identical way in different applications. WordPad is a
basic text editor built into Windows 98. Let’s use it as our example application.

Open an Application (WordPad)
You must first open this application before you can create or modify documents.

1. From the Start Menu, point to Programs, then to Accessories, then select and open the
WordPad application.

Opening WordPad from the Programs Menu

2. A new, blank WordPad document opens.

Enter Text
To enter text into your document, be sure the cursor is blinking in your document, then simply
begin typing.

Editing Text by Selecting, Cutting, Copying,  and Pasting
Editing on the computer is easily accomplished. You can rearrange text in your document by
cutting, copying, and pasting words, sentences, paragraphs, even entire documents.

1. Type a sentence into WordPad. Use the following sentence if you’d like:

“Learning to use the computer can have a positive effect upon my curriculum and student learn-
ing in my classroom.”
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Sentence Typed in WordPad

2. Select the whole sentence by clicking and holding the mouse button just to the left of the first
word (Learning) and then dragging the mouse to the right side of the last word (classroom).

3. Release the mouse when all text is selected.

4. From the Edit menu, select Copy. Now the computer will remember the entire sentence that
you selected.

5. Click the mouse after the last word in the sentence and press Return twice to move the cursor
down to the next line.

6. From the Edit menu, select Paste.

The same sentence you just wrote, selected, and copied, is now pasted into the document. You
can paste the same sentence as many times as you want and the computer will “remember” this
sentence until you either select and copy a new letter, word, or sentence, or until you shut down
the computer.

Undo Command
If you paste a section by mistake, you can “undo” your mistake.

1. From the Edit menu, paste another sentence into your document as described above.

2. From the Edit menu, select Undo.

The text will be erased and the document will revert back to its appearance prior to the last paste.
Some applications, including Microsoft Office 2001, provide an option for multiple Undo com-
mands, which permits you to backtrack through the creation of your document, one step at a
time.
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Save a Document
To save the document you have just created to the hard drive for safe storage and future access,
follow these steps:

1. From the File menu, select Save. Because you have never saved this document before, the
Save As Dialog box opens asking you to "save" the file "as" a named file. Note that the title is
highlighted and ready to be replaced with a title of your choosing.

Save As Window

2. Type Practice Document into the field.

3. Click the View Desktop button to be able to save this document to your desktop.

4. Click Save. The WordPad document is saved to the desktop where an icon appears represent-
ing this file.

Saving Directly to Desired Storage Location
To save a document into a different folder, such as the My Documents folder, instead of the
Desktop, follow these steps:

1. With your WordPad document open, select Save As from the File menu. The Save As win-
dow opens. You can rename your file to save it in the same location as the original. You can also
save the file in any other location whether you rename it or not.

2. Click the View Desktop button. The drop down menu at the top of the dialog box should now
say Desktop.

3. Press the arrow at the right of this menu to see the top levels of your hard drive. Select a
desired location. Note that you can navigate in several levels of your directory to save in a de-
sired location.
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4. Also note that you can create a new folder within the Save As window by clicking the New
Folder button at the level where you wish to create it. Give your newly created folder a title then
click Save to save the document in that location.

Save As
The File menu contains an option to Save As which is used to make new versions or copies of a
document which has already been named and saved. If, for example, you want to save another
copy of this document to modify, yet maintain a copy of this document in its present state, select
Save As... from the File menu and save the document with a different name. You will then have a
duplicate of this document with a different name that you can modify as you wish.

Printing Your Document
Before you are able to print your document, you must inform the computer what printer you
would like to use. Your PC arrived with a companion LexMark printer either in your classroom
or nearby and available through the network. It is probably already set up on your computer. To
check, select Printers from the Settings folder in the Start Menu. Look for a LexMark printer icon
with a checkmark, which indicates that it is the active printer. If this icon is present, you are
ready to print. Otherwise you will need to add this printer by clicking the Add Printer icon and
following the onscreen instructions.

After your printer is set up, follow these steps to print:

1. From the File menu, select Print. The print dialog box opens with options including the
number of copies you wish to print.

2. Click the lower right button titled Print.

3. The printer prints the document.

Closing the Document
Click the close box to close the WordPad document and application.

Additional File Management Techniques
After you have created a file, you may want to move it to a new location, make a duplicate copy, or
delete the file.

Moving a File
An easy way to move a file from one location to another is to have both the original file location
and the target new location in view on the desktop. To move a file to a new location, follow these
steps:

1. Point to the icon for the file you want to move then click and hold down the mouse.

2. Keep holding down the mouse button and drag the file to its new location.
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Use Windows Explorer to Move a File Several Levels in your Directory
You many need to move a file from one folder to another folder that is several levels away in the
directory hierarchy.  To move a file from one folder to another without having both folders open
on the desktop, use Windows Explorer and follow these steps:

1.  Select Windows Explorer from the Programs folder in the Start Menu. The Windows Explorer
window opens.

2.  Find and select the folder in the left pane that contains the file you want to move, which will
appear in the right pane.

3.   In the left pane, navigate to the target location folder so that it is in view, but DO NOT click
to select it.

4. Click and drag the file in the right pane to the target folder in the left pane. The file is moved
to its new location. Click this folder to view the file in its new location in the right pane of
Windows Explorer.

Cutting or Copying and Pasting Files to New Locations
Just as you can cut or copy then paste sections of a document, you can cut or copy then paste files
and folders to new locations. This can be done from open windows on the desktop or within
Windows Explorer. Follow these steps:

1.  From any open window containing files, select a file to copy.

2.  With the file or folder selected, either click the Copy button on the toolbar or select the Copy
command from the Edit menu. A copy of the file or folder is created and placed on a clipboard
ready to be pasted.

Cut, Copy, and Paste Buttons, Open Window Toolbar

3.   Select your target location for the copy of this file or folder. Click the Paste button or choose
the Paste command from the Edit menu. A copy of the file or folder is placed in your target
location.

Deleting a File or Folder
To delete an unwanted file or folder, follow these steps:

1. Select the file or folder you wish to delete.

2. Click the Delete button on the window toolbar or right-click and select the Delete command
from the contextual menu.

Delete Button, Open Window Toolbar
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3. A dialog box appears asking you to confirm that you wish to delete this file. Click Yes.

4. The file is removed from its current location and placed in the Recycle Bin.

Retrieving Files from the Trash
Like papers in the recycle bin in your classroom, it is possible to retrieve files from the Recycle
Bin until it has been emptied. The computer’s Recycle Bin acts like a folder. Double-click the
Recycle Bin icon to view its contents. Drag the items you want to retrieve from the Trash win-
dow into another window or folder or onto the desktop.

Permanently Deleting Files from the Recycle Bin
When you are sure that you no longer need the files located in the Recycle Bin, you can empty it
to free up space on the hard drive.

1. Point to the Recycle Bin and right-click. The contextual menu appears. Select Empty Recycle
Bin.

Selecting Empty Recycle Bin

2. A dialog box opens asking you to confirm that you want to permanently delete all the items
in the Recycle Bin.

Confirm File Delete Dialog Box

3. Click OK to complete this command.

Additional Techniques for Window Management
Other items are helpful to know that will assist you with window management.
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Changing Your View
You can view the contents of open windows in a variety of formats. To change the view for an
open and active window, follow these steps:

1. From the View menu, select your preferred view. The default is to view Large Icons.

2. Other options include viewing window contents as Small Icons, List View and Details.

View Options for Viewing Folders and Files in a Window

Arranging (Sorting) Window Contents
For any view of a window's contents, you can sort the items in the window by Name, Type, Size,
or Date Modified. Simply right-click within the window to open the contextual menu, then point
to Arrange, then select the option for arranging you want. The contents of the window are rear-
ranged into your specified sort order from top to bottom.

In Details view, you can also sort window contents by clicking the respective column heading
within the window. You can also reverse the order that items are listed by clicking the column
heading a second time.

Refreshing the Contents of a Window
The contents of a window change as you create new items or move items to the window. To
make sure you are viewing the most current contents for a window, right-click and select Refresh
from the contextual menu.

Using Your Keyboard
Your PC keyboard is a full size keyboard designed for comfortable use. In addition to keys for
numbers, letters, and symbols, there are function keys.

Keyboard Shortcuts
Keyboard shortcuts, also known as key commands, make it possible to activate certain menu
items without using the mouse.

Most menu items have a keyboard shortcut equivalent listed next to the menu item. For example,
under the File menu, next to the Save item is the keyboard shortcut listed as Ctrl+S or Control+S.
The Ctrl key is located at the left and right lower corners of your keyboard. Pressing and holding
this key while pressing S in an open document executes the Save command. A keyboard com-
mand is equivalent to selecting the menu item with the mouse.

Windows 98 also uses the Alt key for executing key commands, including several for navigation
and file and window management. Many programs support multiple-key key commands. For an
extensive list of keyboard shortcuts for Windows, consult Windows 98 Help.
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Windows 98 System Software and Related Concepts
Just as you can drive a car without knowing exactly how the engine works or how to work on it, you
can operate a PC without understanding exactly how the system software works or how to manipu-
late it. However, just as learning more about your car engine when talking with a mechanic is useful,
learning a bit about the Windows 98 system software can be useful.

Within the "C" drive is a Windows folder. It contains a number of files and folders which were
installed when Windows 98 was loaded onto your computer. The primary files that enable the com-
puter operating system to function are located here. The System folder is located within the Windows
folder, and contains the core files of the operating system.

If you want to look at the contents of the System folder, be sure to not move or delete items from
their original location, as this may cause some programs and/or your computer to function improp-
erly.

Memory Concepts
Memory, also known as RAM (Random Access Memory) is used by the computer to run applica-
tions and perform certain functions. Your computer presently has 128 MB (megabytes) of (RAM)
memory. When the computer starts up, it loads the operating system components from the hard
drive into RAM memory. When you create text in a document, that text is copied and stored in
RAM memory. RAM memory is temporary memory, but your hard drive is permanent. If you turn
the computer off, all items stored in RAM memory will be lost, but items that have been saved
(written) to the hard drive will remain and be available when the computer starts up again. The
more memory your computer has the more applications you can use at the same time and, typically,
the faster the speed of computer processing.

Definitions
Below are a few definitions for items pertaining to memory.

• RAM —Random Access Memory. RAM is temporary memory that the computer uses to run
applications and other functions.

• Memory —Comes in the form of a RAM chip and is installed inside the computer.

• System memory —The operating system requires a certain amount of RAM memory to run the
computer. This is referred to as the system memory.

• Application memory —Each application requires a specific amount of RAM memory to run.
This is referred to as the application memory. When you launch an application, the computer
reserves a certain amount of memory for the application.

Troubleshooting Computer Problems
At times computers will not function properly and will need assistance to recover from the mal-
function. The following situations may occur and require a response to correct the situation.
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First Lines of Defense
• Save often to avoid losing work.
• When your computer appears to be functioning improperly, check to make sure all the cables
are securely plugged in.
• Restarting the computer can often times correct a problem. From the Start Menu, select Shut-
down, then Restart from the dialog box that appears. Be sure to save your work in any open files
before shutting down or restarting the computer.

Frozen Program and Forcing a Restart
If a program is not responding to your mouse clicks or key commands, it may be frozen. But it
may be slowly processing a previous command, in which case patience often does the trick. If it
continues to be unresponsive, you should attempt to end the current task. You may be able to
unfreeze the program or force the application to quit by pressing the following key combination
(pressing all keys simultaneously): Ctrl+Alt+Delete.

Ideally, this ends the current task while keeping the program and current file open. If this key
combination unfreezes the program, be sure to save your work before proceeding. Another
possibility is that this command forces the application to quit. You will lose any unsaved work in
the application that quits, however, you will still have the opportunity to not only save work that
may be open in other applications but also restart the computer properly from using the Shut-
down command from the Start Menu. Restarting the computer helps by refreshing the system
software and clearing operating problems.

If the situation is more dire, you may need to force the computer to restart by pressing
Ctrl+Alt+Delete a second time. Windows will shut itself down.

Hard Restart
The force restart described above will not always work. If the computer ceases to function and a
soft restart does not work, you have no option but to restart the computer. Press the power button
on the front of the PC to force the computer to shut down. If this does not work, you will need to
disconnect the power cable, which forces the computer to shut off. Reconnect the power cable
and restart the computer.

Use Help Resources and Available Tech Support
When you encounter problems with your computer, remember to use Windows Help resources as
possible to learn about, understand, and respond to basic computer problems.

For assistance especially with more complex computer problems, contact your site or district tech
support staff.

Shutting Down Your Computer
The computer has sensitive hardware and software components that can be damaged if the
computer is not shut down properly. To avoid damaging these items, be sure that the computer is
fully turned off and powered down before unplugging it whenever possible.
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To turn off the computer, follow these steps:

1. Point to the Start menu and click or press the Windows key on your keyboard. The Start
menu opens.

2. Click to select Shut Down. The Shut Down dialog box opens.

3. Select Shut Down from the available choices, then click OK.

4. Allow your computer to shut down completely. No further action is required.



 Windows 98 and Peripherals 37

Closing Thoughts
Windows 98 is a sophisticated operating system that runs your PC computer. Continuing to expand
your knowledge of the operating system will lead to a greater understanding of how your computer
works. Developing your ability to interact with the operating system will increase the ease and
efficiency of using your computer.

Resources
A list of linked web resources can be found on the Windows 98 Resources page.
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